


Preface
Some books zoom through a software program so fast it
makes your head spin. You'll come out dizzy, but basically
able to cobble together some sort of result, even if it
doesn't look quite right. This is not one of those books.
The PowerPoint 2010 Bible is probably the only PowerPoint
book you will ever need. In fact, it might even be the only
book on giving presentations you'll ever need. No,
seriously! I mean it.
As you probably guessed by the heft of the book, this is not
a quick-fix shortcut to PowerPoint expertise. Instead, it's a
thoughtful, thorough educational tool that can be your
personal trainer now and your reference text for years to
come. That's because this book covers PowerPoint from
“cradle to grave.” No matter what your current expertise
level with PowerPoint, this book brings you up to the level
of the most experienced and talented PowerPoint users in
your office. You might even be able to teach those old pros
a thing or two!
But this book doesn't stop with PowerPoint procedures.
Creating a good presentation is much more than just
clicking a few dialog boxes and typing some text. It
requires knowledge and planning—lots of it. That's why this
book includes a whole chapter on planning a presentation,
and another whole chapter on the practical issues involved
in presenting one. You learn things like the following:

How to select the best color schemes for selling and
informing
How to gauge the size of the audience and the meeting
room when selecting fonts



How to arrange the tables and chairs in the meeting
room to encourage (or discourage) audience
participation
How to choose what to wear for a live presentation
How to overcome stage fright

And lots more! When you finish this book, you will not only
be able to build a presentation with PowerPoint, but you'll
also be able to explain why you made the choices you did,
and you'll deliver that presentation smoothly and with
confidence.
If you are planning a presentation for remote delivery (for
example, posting it on a Web site or setting up a kiosk at a
trade show), you'll find lots of help for these situations too.
In fact, an entire section of the book is devoted to various
nontraditional presentation methods, such as live Internet
or network delivery, trade show booths, and interactive
presentation distribution on a disk or CD.



How This Book Is Organized
This book is organized into parts, which are groups of
chapters that deal with a common general theme. Here's
what you'll find:

Part I: Building Your Presentation. In this part, you
start building a robust, content-rich presentation by
choosing a template, entering your text, and applying
text formatting.
Part II: Using Graphics and Multimedia Content.
This part teaches you how to import and create various
types of graphical and multimedia content including clip
art, diagrams, photos, charts, sound effects, movies, and
music. You'll also learn here how to create movement
with animation effects and transitions.
Part III: Interfacing with Your Audience. This part
helps you prepare your presentation for various delivery
scenarios, including printing handouts for a live
audience, running a live show on a computer screen,
designing visual aids for user-interactive or self-running
presentations, and sharing a collaborating with others.
Part IV: Project Labs. This part provides four step-by-
step walkthroughs that demonstrate how to create some
of the most powerful and sought-after PowerPoint effects
and projects, including creating navigation systems,
classroom games, complex animations, and graphically
presented text.

What's on the companion CD-ROM
The CD-ROM included with PowerPoint 2010 Bible contains
more than 500 PowerPoint templates and backgrounds that
you can use to design your own PowerPoint presentations.
If you aren't familiar with how to choose a background or



template for your presentation, be sure to read Chapter 3
in this book, which discusses templates, and Chapter 5,
which includes the backgrounds discussion, before
attempting to use the CD-ROM. Please see the CD-ROM
Appendix for more information on the professional
designers who supplied the templates for your use. The CD-
ROM also contains author files for use in the Project Labs
in Part IV.

Special Features
Every chapter in this book opens with a quick look at
what's in the chapter and closes with a summary. Along the
way, you also find icons in the margins to draw your
attention to specific topics and items of interest.
Here's what the icons mean:

Cross-Reference

These icons point you to chapters or other sources for
more information on the topic under discussion.

Note

Notes provide extra information about a topic, perhaps
some technical tidbit or background explanation.

Tip

Tips offer ideas for the advanced user who wants to get
the most out of PowerPoint.



Caution

Cautions point out how to avoid the pitfalls that
beginners commonly encounter.

Good luck with PowerPoint 2010! I hope you have as much
fun reading this book as I had writing it. If you would like
to let me know what you thought of the book, good or bad,
you can e-mail me at faithe@wempen.com. I'd like to hear from
you!



Part I
Building Your Presentation

In This Part
Chapter 1 A First Look at PowerPoint
Chapter 2 What Makes a Great Presentation?
Chapter 3 Creating and Saving Presentation Files
Chapter 4 Creating Slides and Text Boxes
Chapter 5 Working with Layouts, Themes, and Masters
Chapter 6 Formatting Text
Chapter 7 Formatting Paragraphs and Text Boxes
Chapter 8 Correcting and Improving Text
Chapter 9 Creating and Formatting Tables



Chapter 1
A First Look at PowerPoint
In This Chapter

Who uses PowerPoint and why?
What's new in PowerPoint 2010?
Learning your way around PowerPoint
Changing the view
Zooming in and out
Displaying and hiding screen elements
Working with window controls
Using the help system and getting updates

PowerPoint 2010 is a member of the Microsoft Office 2010
suite of programs. A suite is a group of programs designed
by a single manufacturer to work well together. Like its
siblings—Word (the word processor), Excel (the
spreadsheet), Outlook (the personal organizer and e-mail
manager), and Access (the database)—PowerPoint has a
well-defined role. It creates materials for presentations.
A presentation is any kind of interaction between a speaker
and audience, but it usually involves one or more of the
following visual aids: 35 mm slides, overhead
transparencies, computer-based slides (either local or at a
Web site or other network location), hard-copy handouts,
and speaker notes. PowerPoint can create all of these types
of visual aids, plus many other types that you'll learn about
as you go along.



Because PowerPoint is so tightly integrated with the other
Microsoft Office 2010 components, you can easily share
information among them. For example, if you have created
a graph in Excel, you can use that graph on a PowerPoint
slide. It goes the other way, too. You can, for example, take
the outline from your PowerPoint presentation and copy it
into Word, where you can dress it up with Word's powerful
document formatting commands. Virtually any piece of data
in any Office program can be linked to any other Office
program, so you never have to worry about your data being
in the wrong format. PowerPoint also accepts data from
almost any other Windows-based application, and can
import a variety of graphics, audio, and video formats.
In this chapter you'll get a big-picture introduction to
PowerPoint 2010, and then we'll fire up the program and
poke around a bit to help you get familiar with the
interface. You'll find out how to use the tabs and panes, and
how to get help and updates from Microsoft.

Who Uses PowerPoint and Why?
PowerPoint is a popular tool for people who give
presentations as part of their jobs, and also for their
support staff. With PowerPoint, you can create visual aids
that help get the message across to an audience, whatever
that message may be and whatever format it may be
presented in. Although the traditional kind of presentation
is a live speech presented at a podium, advances in
technology have made it possible to give several other
kinds of presentations, and PowerPoint has kept pace
nicely. The following list outlines the most common
PowerPoint formats:

Podium: For live presentations, PowerPoint helps the
lecturer emphasize key points through the use of



overhead transparencies, 35 mm slides, or computer-
based shows.
Kiosk shows: These are self-running presentations that
provide information in an unattended location. You have
probably seen such presentations listing meeting times
and rooms in hotel lobbies and as sales presentations at
trade show booths.
CDs and DVDs: You can package a PowerPoint
presentation on a CD or DVD and distribute it with a
press release, a marketing push, or a direct mail
campaign. The presentation can be in PowerPoint
format, or can be converted to Web format or even a
movie clip, for distribution.
Internet formats: You can use PowerPoint to create a
show that you can present live over a network or the
Internet with a service such as PowerPoint Live, while
each participant watches from his or her own computer.
You can even store a self-running or interactive
presentation on a Web site in a variety of formats and
make it available for the public to download and run on
a PC.

When you start your first PowerPoint presentation, you may
not be sure which delivery method you will use. However,
it's best to decide the presentation format before you invest
too much work in your materials, because the audience's
needs are different for each medium.

Cross-Reference

You learn more about planning your presentation in
Chapter 2.



Most people associate PowerPoint with sales presentations,
but PowerPoint is useful for people in many other lines of
work as well. The following sections present a sampling of
how real people just like you are using PowerPoint in their
daily jobs.

Sales
More people use PowerPoint for selling goods and services
than for any other reason. Armed with a laptop computer
and a PowerPoint presentation, a salesperson can make a
good impression on a client anywhere in the world. Figure
1.1 shows a slide from a sample sales presentation.

Figure 1.1: PowerPoint offers unparalleled flexibility for
presenting information to potential customers.



Sales possibilities with PowerPoint include the following:

Live presentations in front of clients with the
salesperson present and running the show. This is the
traditional kind of sales pitch that most people are
familiar with.
Self-running presentations that flip through the slides at
specified intervals so that passersby can read them or
ignore them as they wish. These types of presentations
are great for grabbing people's attention at trade show
booths.
User-interactive product information demos distributed
on CD/DVD that potential customers can view at their
leisure on their own PCs. This method is very
inexpensive, because you can create a single
presentation and distribute it by mail to multiple
customers.

Cross-Reference

See Chapter 20 to learn about controlling a live
presentation. You create a self-running or user-
interactive presentation in Chapter 21.

Marketing
The distinction between sales and marketing can be rather
blurred at times, but marketing generally refers to the
positioning of a product in the media rather than its
presentation to a particular company or individual.
Marketing representatives are often called upon to write
advertising copy, generate camera-ready layouts for print
advertisements, design marketing flyers and shelf displays,
and produce other creative selling materials.



PowerPoint is not a drawing program per se, and it can't
substitute for one except in a crude way. However, by
combining the Office 2010 clip art collection and drawing
tools with some well-chosen fonts and borders, a marketing
person can come up with some very usable designs in
PowerPoint. Figure 1.2 shows an example. You learn about
clip art in Chapter 12. You can also integrate video clips in
PowerPoint presentations that can tell the story of your
product; see Chapter 17 for more information.

Figure 1.2: PowerPoint can generate camera-ready
marketing materials, although they can't substitute for the
tools that professional advertising companies use.

Human Resources



Human resources personnel often find themselves giving
presentations to new employees to explain the policies and
benefits of the company. A well-designed, attractive
presentation gives the new folks a positive impression of
the company they have signed up with, starting them off on
the right foot.
One of the most helpful features in PowerPoint for the
human resources professional is the Organization Chart
tool. With it, you can easily diagram the structure of the
company and make changes whenever necessary with a
few mouse clicks. Figure 1.3 shows an organization chart
on a PowerPoint slide. You can also create a variety of other
diagram types. Organization charts and other diagrams are
covered in Chapter 11.



Figure 1.3: Microsoft's Organization Chart lets you easily
create organizational diagrams from within PowerPoint.

Education and Training
Most training courses include a lecture section in which the
instructor outlines the general procedures and policies.
This part of the training is usually followed up with
individual, hands-on instruction. PowerPoint can't help
much with the latter, but it can help make the lecture
portion of the class go smoothly.
If you have access to a scanner, you can scan in diagrams
and drawings of the objects you are teaching the students
to use. You can also use computer-generated images, such
as screen captures and video clips, to teach people about
software.



PowerPoint's interactive controls even let you create
quizzes that each student can take on-screen to gauge his
or her progress. Depending on the button the student
clicks, you can set up the quiz to display a “Yes, you are
correct!” or “Sorry, try again” slide. See Figure 1.4. For
details about this procedure, see Chapter 21 and Lab 4 in
the Project Labs section at the end of the book.

Figure 1.4: Test the student's knowledge with a user-
interactive quiz in PowerPoint.

Hotel and Restaurant Management
Service organizations such as hotels and restaurants often
need to inform their customers of various facts but need to
do so unobtrusively so that the information will not be
obvious except to those looking for it. For example, a



convention center hotel might provide a list of the meetings
taking place in its meeting rooms, or a restaurant might
show pictures of the day's specials on a video screen in the
waiting area.
In such unattended situations, a self-running (kiosk)
presentation works best. Typically the computer box and
keyboard are hidden from passersby, and the monitor
displays the information.

Cross-Reference

You learn more about kiosk setups in Chapter 21.

Clubs and Organizations
Many nonprofit clubs and organizations, such as churches
and youth centers, operate much the same way as for-profit
businesses and need sales, marketing, and informational
materials. But clubs and organizations often have special
needs too, such as the need to recognize volunteers for a
job well done. Office online provides a Certificate template
that's ideal for this purpose. Figure 1.5 shows a certificate
generated in PowerPoint. Another popular use for
PowerPoint is to project the lyrics of a song on a big screen
for sing-alongs at churches and meetings.



Figure 1.5: With PowerPoint, you can easily create
certificates and awards.

What's New in PowerPoint 2010?
PowerPoint 2010 is very much like PowerPoint 2007 in its
basic functionality. It uses a tabbed Ribbon across the top,
rather than a traditional menu system, and employs dialog
boxes and a Quick Access Toolbar in the same ways that
2007 did.
This doesn't mean that there aren't changes and
improvements, though! The following sections outline the
major differences you will see when you upgrade from
PowerPoint 2007 to PowerPoint 2010.



Backstage View
The File tab in the upper left corner of the PowerPoint
window replaces the Office button from PowerPoint 2007.
Clicking it opens a full-screen File menu system, also
known as Backstage view.
From Backstage view, you can select file operations such as
saving and printing, customizing the interface, and sharing
your work with others. Figure 1.6 shows Backstage view. To
leave Backstage view, click any other tab.

Figure 1.6: Backstage view (a.k.a. the File menu) provides
access to various file management and customization
commands.

Better Support for Video Import and Editing
One of the features most asked for in PowerPoint has been
support for more video file formats, and PowerPoint 2010
has delivered it. PowerPoint 2010 supports a wide variety



of formats including QuickTime, Flash, Windows Media,
and MP4. You can now also link video clips from online
sources such as YouTube.
Not only can you import motion video from a larger variety
of sources than in earlier versions, but you can also edit
videos directly from within PowerPoint. For example, you
can change the brightness and contrast of a video, trim it
to show only certain parts, add a bookmark in the video clip
(which you can then hyperlink to, to jump to a particular
spot in the video quickly), and more. Figure 1.7 shows the
Format tab in PowerPoint 2010's Video Tools.

Figure 1.7: Enhanced video tools enable you to modify the
video clip without leaving PowerPoint.

Output to Video and DVD
Another feature in high demand has been the ability to
output a presentation directly to popular video formats. In
the past, people have had to resort to third-party solutions,
but PowerPoint 2010 includes this capability built-in. You
can now output your presentation to Windows Media Video
(.wmv) format, which can be played back by Windows
Media Player or a variety of other utilities.

Collaboration
Collaborating with others on a draft presentation is now
easier to do. PowerPoint now includes a Compare feature
that includes revision tracking. With revision tracking you
can see who has made what changes to the presentation,
and review each change individually to accept or reject it,
as shown in Figure 1.8.



Figure 1.8: You can track changes to a presentation draft to
organize the work of multiple collaborators.

Other Changes
Besides the major changes you've learned about in the
preceding sections, there are also a number of smaller but
still important improvements, including these:

New photo editing tools allow you to apply artistic filters
to pictures, remove backgrounds, and crop with more
precision.
New transition effects are available in PowerPoint 2010,
and they are now easier to apply, thanks to the new
Transitions tab on the Ribbon.
You can now insert math equations into a presentation
with the Microsoft Office Equation Editor. Equation
editing was revamped in some of the other Office



applications in Office 2007, but PowerPoint is only now
getting the new and improved equation interface.
You can customize the Ribbon by adding, removing, and
rearranging commands and tabs. This is a new feature
across all of the Office 2010 applications, and very
welcome to power users who like to control their
working environment on-screen.
Presentation broadcasting is much improved in
PowerPoint 2010 because of its integration with the
Web-based PowerPoint Live service.

Learning Your Way around
PowerPoint
Now that you have seen some of the potential uses for
PowerPoint and toured the new features, let's get started
using the program.
PowerPoint is one of the easiest and most powerful
presentation programs available. You can knock out a
passable presentation in a shockingly short time by
skimming through the chapters in Parts I and II of the
book, or you can spend some time with PowerPoint's
advanced features to make a complex presentation that
looks, reads, and works exactly the way you want.

Starting and Exiting PowerPoint
You can start PowerPoint just like any other program in
Windows: from the Start menu. Follow these steps:

1. Click the Start button. The Start menu opens.
2. Click All Programs.
3. Click Microsoft Office.



4. Click Microsoft PowerPoint 2010. The program starts.

If you have opened PowerPoint before, a shortcut to it
might appear in the Recently Used Programs list, which is
directly above the All Programs command on the Start
menu. If you use other applications more frequently than
PowerPoint, PowerPoint may scroll off this list and you
therefore have to access it via the All Programs menu.

Tip

If you don't want to worry about PowerPoint scrolling off
the list of the most frequently used programs on the
Start menu, right-click PowerPoint's name on the Start
menu and choose Pin to Start Menu. PowerPoint will
then appear on the list at the top of the left column of
the Start menu, as shown in Figure 1.9. To remove it
from there later, right-click it and choose Unpin from
Start Menu.



Figure 1.9: A shortcut to PowerPoint might appear on the
top level of the Start menu.
When you are ready to leave PowerPoint, select File ⇒ Exit
or click the Close (X) button in the top-right corner of the
PowerPoint window. (The File button is the orange tab in
the top-left corner.) If you have any unsaved work,
PowerPoint asks if you want to save your changes. Because
you have just been playing around in this chapter, you
probably do not have anything to save yet. (If you do have
something to save, see Chapter 3 to learn more about
saving.) Otherwise, click No to decline to save your
changes, and you're outta there.

Understanding the Screen Elements
PowerPoint's interface is typical of any Windows program
in many ways, but it also has some special Office 2010–
specific features as well. The PowerPoint window contains
these elements, pointed out in Figure 1.10:



Title bar: Identifies the program running (PowerPoint)
and the name of the active presentation. If the window is
not maximized, you can move the window by dragging
the title bar.
Ribbon: Functions as a combination of menu bar and
toolbar, offering tabbed “pages” of buttons, lists, and
commands. The next section describes it in more detail.
File tab: Opens the File menu (Backstage view), from
which you can open, save, print, and start new
presentations.
Quick Access Toolbar: Contains shortcuts for some of
the most common commands. You can add your own
favorites here as well.
Minimize button: Shrinks the application window to a
bar on the Windows taskbar; you click its button on the
taskbar to reopen it.
Maximize/Restore button: If the window is maximized
(full screen), it changes to windowed (not full screen). If
the window is not maximized, clicking here maximizes it.
Close button: Closes the presentation. You may be
prompted to save your changes, if you made any.
Work area: Where active PowerPoint slide(s) appear.
Figure 1.10 shows it in Normal view, but other views are
available that make the work area appear differently.

Cross-Reference

See the section “Changing the View” later in this
chapter for details.

Status bar: Reports information about the presentation
and provides shortcuts for changing the view and the



zoom.

Note

Because this isn't a Windows book, Windows controls
are not covered in detail here. However, if you're
interested in learning more about Windows-based
programs in general, pick up Windows 7 For
Dummies or The Windows 7 Bible, also published by
Wiley. Windows Vista and Windows XP versions of
these books are also available.

Figure 1.10: The PowerPoint window is a combination of
usual Windows features and unique Office 2010 elements.



Working with the Ribbon
As mentioned earlier in the chapter, PowerPoint 2010's
user interface is based on the Ribbon, which is a bar across
the top of the window that contains tabbed pages of
commands and buttons. Rather than opening a menu and
selecting a command, you click a tab and then click a
button or open a list on that tab.
Here are some important terms you need to know when
working with tabs:

Ribbon: The whole bar, including all of the tabs.
File tab: A tab-like button that opens Backstage view,
from which you can choose to start a new presentation,
save, print, and perform other file-related activities. See
Figure 1.10 for this button's location.
Quick Access Toolbar: A small toolbar adjacent to the
Office button from which you can select commonly used
commands.

Tip

To add a command to the Quick Access Toolbar, right-
click the toolbar and choose Add to Quick Access
Toolbar. To remove the command from there, right-
click the command icon and choose Remove from
Quick Access Toolbar.

Tab: A tabbed page of the Ribbon. Figure 1.11 shows
the Home tab, for example.
Contextual tab: A tab that appears only when certain
content is selected, such as a graphic or a chart. The
context name appears above the tab name. In Figure



1.11, Drawing Tools is the context name for the Format
tab.
Group: A section of a tab. The Home tab shown in
Figure 1.11 has the following groups: Clipboard, Slides,
Font, Paragraph, Drawing, and Editing.
Dialog box launcher: A small icon in the bottom-right
corner of a group, from which you can open a dialog box
related to that group.

Note

To find out what a toolbar button does, point the
mouse at it. A ScreenTip pops up explaining it.

Figure 1.11: The Ribbon is PowerPoint 2010's primary user
interface.

Working with Collapsible Tab Groups
Within a tab, groups can expand or collapse depending on
the width of the PowerPoint window. When the window is
large enough (somewhere around 1100 pixels), everything
within each group is fully expanded, so that each item has
its own button. When the window is smaller, groups start
collapsing so that all groups remain visible. At first, large
buttons get smaller and stack vertically; if that's not
enough, then groups collapse into single large buttons with



drop-down lists from which you can select the individual
commands. Figure 1.12 shows the same tab in three
different widths for comparison.

Caution

Because of the Ribbon's collapsing ability, the exact
steps for performing certain procedures depend on the
active PowerPoint window's width. A small window may
require an extra step of opening a button's menu to
select a command, for example. For a large window,
each command appears directly on the tab. This book
assumes an average window size of 1024 x 768 pixels; if
you run PowerPoint at a smaller resolution, you may
occasionally have an extra step to access a command.

Figure 1.12: The size of the PowerPoint window determines
how much the groups are collapsed or expanded on the
Ribbon.

Working with Backstage View
When you open Backstage view by clicking the File tab, a
multilayered menu system appears. Many of the commands
along the left side of the screen are categories that open
submenus when you click them. For example, in Figure



1.13, the Share command has been selected, revealing
additional choices.

Figure 1.13: In Backstage view, most of the main
commands open a submenu or a dialog box.

The top-level categories and commands in Backstage view
are:

Save: Saves the current presentation.
Save As: Saves the current presentation and prompts
you for file name and location information, even if the
file has been previously saved.
Open: Displays the Open dialog box, from which you
can select a file to open.
Close: Closes the active presentation.


